
Issue 2 of OmniDirectional brings
significant news of major develop-
ments within Blyth and DLA. The
release of the “Editions” strategy has
resulted in many new sales, particular-
ly the Workgroup product, so there
are now many new Omnis
Developers.

During the coming months DLA will
launch an Omnis seeding campaign
with a time limited CD version of 3.2.
Our aim is to introduce Omnis to pro-
grammers throughout Australasia and
thereby increase our market penetra-
tion.

DLA software support programmes
have been well received as local
developers take advantage of the
partner benefits offered. At all times
our staff are here to assist developers
and support is now percieved as a
major benefit.

On behalf of all at DLA, seasons greet-
ings and a profitable New Year!

David P. Lewis
Managing Director

OMNIS in
the CLASSROOM

Been to school lately?  What drives the
operation of schools? Are they businesses
(admittedly dealing with people, not
things), or are they of a different essence?
And what happens
in a business organ-
isation where over a
thousand people are
involved?  What’s
the role of comput-
ers? What of the
adults valiantly try-
ing to keep up with
the devastating ease
with which modern
youth masters the
latest software or
the new machines? 

Schools are busi-
nesses, and have to
deal with inputs and
products and
account to someone
for what is happen-
ing just l ike any
medium sized man-
ufacturing firm, but
they are also differ-
ent because the peo-
ple in the organisa-
tion: students, par-
ents, teachers, all
relate to one another
in a myriad of dif-
ferent ways: they
belong to different
classes, different
teams; they do
activities that attract
dollar charges that vary from individual
to individual; they run events at different
times and place. 

Twenty years ago schools had numbers
of “support staff” who spent most of their
time typing out lists: lists not of compo-
nents or products, but of groups of names
in particular relationship to each other.
Today all schools almost certainly have
replaced their typewriters with word
processors, but often that is all: perhaps
there are several - or even one- “flat-file”

systems that
generate the
lists for those
working in
the place.

Six years ago,
faced with a
rapidly grow-
ing new
school,  and
d e v e l o p i n g
procedures to
collect and
copy boring
data from list
to list, I deter-
mined to use
the appropri-
ate technolo-
gy to ensure
that ours was
a school
where no per-
son was
employed to
type or copy
lists; where
the driving
force for
record keep-
ing rather was
the need to
use it now,
and the
accessing of

the information later was taken care of
automatically. O M N I S
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Consider for a moment an
example of the way in which
team lists are used in a school.
The sports teacher or coach
uses a list to post up the bas-
ketball teams. Copies of this
list ideally should then be
passed to house patrons or roll
teachers for copying across to
each student’s records, as well
as to the accountant’s office
for charging for bus fares or
hire of equipment, to the
archives section for recording
for posterity, to the Principal’s
office for recording for refer-
ence writing, etc.

We determined to use a rela-
tional database working
through an interface that was
simple enough for any staff
member to use; where the dif-
ferent sections all worked in
the same way so that driving it
would be intuitive, and where
the operation would be almost
entirely by the actual teaching
staff more so than clerical per-
sons. In particular, we have

resisted the idea of having a
data-entry-clerk!!

The specifications are now
getting close. The database
engine must be inexpensive;
the interface must be easy to
modify - even by the user - to
allow easy changes in the way
things are done. No two
schools ever do things in
exactly the same way, and no
teacher of administrator worth
anything will accept the idea
that “we can’t do that: the
computer isn’t set up to allow
it”. Most schools often change
things almost for change’s
sake from year to year.

The system must be integrat-
ed. If data-entry was to be
eliminated, then the staff
themselves, those actually
using the thing had to have
access and write-privileges to
the datafile, rather than just
exported data from a cen-
tralised list.

Finally of course, most
schools use mixed platforms:
accounting sections use IBM
compatibles; teachers general-
ly prefer Macs. Office staff
might use either. Only the
Omnis relational database
meets all these criteria, and
Omnis 7 is powerful enough
easily to handle the most com-
plex organisation .  
We in fact began in the earli-
est days of Omnis 5, which
provided the familiar GUI
environment for our budding
Macusers back in 1990.  The
application was an update of
an earlier Omnis 3.0 (non-
GUI) programme Richard Ure
had written and which some
schools were using for some
of their operations. He called
the application “Omnibus”,
which was nicely evocative of
its integrated concept: every-
thing about the school in
together. The programme then
was just over half the size it is
now!

In those days, one Mac SE
operating in single-user mode
provided access for the three
or four regular ‘power-users’.
Five years later the datafile
resides on a small workgroup
server running Appleshare; a
10-user licence means that as
yet no conflicts have occurred
even though 15 or more
machines scattered all over the
school, linked with a mixture
of Local Talk and Ethernet
(Cat 5 twisted pair), get heavy
staff use. The next hardware
step forward is likely to be to
move the Omnis system to the
same Novell network that runs
the Library CD system, which
gives faster access still, and
automatic backups.

By Philip Bryson
Headmaster; 
William Clarke College
Contact:
http://www.magna.com.au/~la
ngy/wcc_top.html
Phone:  (02) 629-3200  
Fax: (02) 629-3237 
E-mail: 
Philip_Bryson@aapda.com.au

Personal
Oracle
The Oracle Corporation pro-
vides a limited life version of
Personal Oracle which is
excellent for prototyping pur-
poses. Personal Oracle can be
obtained on CD or directly
from the Oracle WWW sites
(see Page 4). Personal Oracle
is Windows only at this time
and requires 16 megs of
RAM. The rumour mill has
indicated that a Power Mac
version of Personal Oracle
will be released in the next
three months.

The 32 bit
Advantage
A simple (non-Omnis) test
program was used in-house to
compare a small application
that automatically generates
1400 records over 6 file for-
mats. A Pentium 90 clone was
used with 16 megs of RAM
and 32 bit compatible hard-
ware. Running Windows for
Workgroups the test applica-
tion took 5 minutes and 15
seconds to generate the
records. Running Windows
NT 3.5 the application took 16
seconds to generate these
records. Running Windows 95
the application took 12 sec-
onds to generate the records
(curiously Windows 95 is not
meant to be 32 bit compatible
yet!). The time included all
disk I/O. All operating sys-
tems were run with default
settings. On the basis of these
results, the 32 bit Microsoft
Operating Systems are an
extremely attractive proposi-
tion, particulary NT, which is
universally regarded as a high-
ly stable operating system.
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Windows 95,
Windows 3.11
and Windows NT 
Installing multiple operating systems can
be a lot simpler than imagined. Let’s start
with a standard machine setup with a
DOS and either WfW or Win 3.11
installed.....

To install Windows NT you simply do a
default install as per the instructions.
When you are finished and the machine
restarts it will boot from Windows NT by
default and then gives the user the option
of running Windows NT or running DOS.
If you choose the NT option then NT will
start, if you choose DOS then WfW or
Win3.11 will start depending on which
one you have installed.

To install Windows 95 attempt a default
install. When the installer detects
Windows NT files in the C:\WINDOWS\
directory it will then request if you wish
to load 95 over NT or choose a different
directory to keep your NT settings. You
should choose a new directory which
defaults to C:\WINDOWS00\. If you
haven’t installed Windows NT  you
should choose the ‘other directory’ option
in any event to preserve your current set-
tings.

Now with the three operating systems on
startup the NT bootmanager will run. To
run NT you choose the NT option.  To
run Windows 95 you choose the DOS
option. After Windows 95 is running
choose shutdown from the START icon
and choose shutdown to DOS. When
Windows 95 has shutdown to the DOS
prompt type C:\WINDOWS\WIN (or the
location of your WfW or Win 3.11 startup
if not this path)  and WfW or Win 3.11
will run. (If you haven’t installed
Windows NT then your computer will
boot to Windows 95 and you use the same
approach to get to the DOS prompt and
boot WfW.

Other more elegant and expensive meth-
ods are available such as using the OS/2
Boot Manager or one of the numerous 3rd
party products advertised in the US
Developer Magazines.

Appleshare for PC
Customers who purchase any Workgroup
Server after January 1, 1995, are eligible
to receive the AppleShare Client for

Windows software free of charge.
Workgroup Server customers who pur-
chased their server before January 1,
1996, as well as customers who pur-
chased AppleShare software separately,
can purchase the AppleShare Client for
Windows software through authorised
Apple resellers.

Both the AppleShare and AppleSearch
Client for Windows products come with a
network licence that allows distribution of
the Windows client software to any
Windows software DOS based computer
connected to the network.

http://www.info.apple.com/wwcc/win-
client.html

Price Competitive!
Omnis is now the cheapest multi-user
relational database solution on the Mac.
With the Workgroup Product an Omnis
solution is considerably cheaper than
either a 4D based solution or a Helix solu-
tion. A fiver user configuration would be
approximately:

Omnis $799 
(with 10 users)
Helix $2,299 
(development environment plus 5 user
client server solution).
4D $2,500-3,000 
(4D First as Runtimes plus 4D Server)
Omnis and Butler $1,799

Lost all 
procedures?
If a Mac Omnis application and the pro-
cedure lines have either been damaged or
completely erased then it is likely the
minimum memory requirement of the
Omnis executable has been set too low.
Install a fresh copy of the library and
increase the memory requirement by one
megabyte and try again.

Shared Libraries
If a library is sharable, that is the library
attribute is set to true,  the speed of execu-
tion of the library is affected. To improve
the speed of execution of your code,
where appropriate, add a command to
your startup routine as follows:
Calculate $ksharable as kFalse.

Square Bracket
Notation &“eval”
The following short snippet contains an
example of the tremendous capability of
developing generic code in 7.3.2. Square
bracket notation works virtually every-
where and particulary in Finds and
Calculate Commands.

Calculate #S5 as 55
Calculate #S3 as ‘#S5’
Calculate #S2 as eval(#S3)
;#S2 now has the value 55
Calculate #S4 as ‘#S1’
Calculate [#S4] as eval(#S3)
;#S1 now has the value 55

Cross Tabs &“Use
field of name”
The problem was basically one of cross
tabs. I wanted to accumulate in each of 12
fields MEW1..MEW12 the totals of the
amount of work done (WIAMOUNT) in
each of the twelve months of the year.

The relevant part of the calculation which
has worked since O5 is:

Repeat
Calculate #S5 as
con(‘MEW’,dtm(WIDATE)+0)
Calculate #S5 as
fld(#S5)+WIAMOUNT (Use fld() of
name)
Next 
Until flag false

The first line puts into #S5 the calculated
name of the required field based on the
month number of the WIP record being
processed eg (MEW6).

The second line ensures  the amount of
the currently processed WIP record is
added to MEW6 or whatever.
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“Calculate #S5 as {calculation} (Use
fld() of name”
“ fld(#s5) + WIAMOUNT”

By Richard Ure
Richard_Ure@aapda.com.au

Select for
Deletion Tip
Here’s a pretty basic tip but
one I find very useful.

When you are stepping
through a list of items in a
loop and processing each
line, you may want to delete
lines with no value. Deleting
a line while stepping through
the list requires a little work
to make sure you get every
line once, especially if using
a ‘For each line in the list’
loop. So, instead of deleting
lines on the fly select them,
and do the line deletion at the
end.

Deselect list line(s) (All
lines)
For each line in list from 1 to
#LN step 1

If not(T_AMOUNT)&lst(T_RSN)
Single file find on T_RSN

{lst(T_RSN)}     ;; There is a trans-
action record but no amount

Delete
Select list line(s) {#L}

Else If not(T_AMOUNT)
Select list line(s) {#L}     ;; There

is no transaction record and no
amount.

End If
End For
Delete selected lines

By Jonathan Rumbold
Melbourne, Australia
jonr@netspace.net.au

Re-Organize Data
Command:
Comparing  7.1 &
7.3
Developers attention is drawn to the dif-
ference in the way the Utilities function,
Re-organize, operates in 7.3.x compared

to version 7.1.x. In 7.1.x, and all earlier
versions of Omnis, the Re-Organise
forced a re-index of the index tables asso-
ciated with every file format. This is no

longer the case, the Re-Organise func-
tion first tests to see whether the

there is a difference between the
data dictionary in the library and
the datafile and only proceeds
with a Re-Organise if this
process detects a difference
between the library datafile
header and the selected
datafile header. If you wish to
rebuild and index the you
should use the drop index-
rebuild index commands pro-
cedurally.

$canfocus-
buttons:
This notation option was intro-
duced to increase the cross-
platform compatibil ity of
OMNIS. In the Windows envi-

ronment it is standard for the
user to tab onto a button and for

that button to have focus. Omnis
allows three options for button

focus: kPlatformdefault, kNofocus
and kFocus.

Calculate
$root.$libs.My_Lib.$prefs.$canfo-
cusbuttons as kFocus
Calculate
$root.$libs.My_Lib.$prefs.$canfo-
cusbuttons as kNofocus
Calculate
$root.$libs.My_Lib.$prefs.$canfo-
cusbuttons as kPlatformdefault

or:

Calculate $clib.$prefs.$canfocusbut-
tons as kFocus

DML and SQL
It is not recommended that applications
access an Omnis datafile using both
OmnisSQL and the Native Data
Manipulation simultaneously. This fea-
ture is under development for a future
release and although the code may seem
to work faultlessly, Blyth does not war-
rant that it will work reliably until Quality
Assurance is complete.
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OMNIS RELATED
INTERNET SITES...
Omnis Related Sites on the Internet and
Elsewhere:

Compuserve:
Blyth Forum  (Go Blyth)

AAPDA BBS:
First Class Software Required

Data: (02) 975 4332

IP: 203.14.177.200

For Membership Details contact Christine

Gargan:

Ph: (02) 452 8245

Fax: (02) 975 6397

Mailing List:
omnis@lanl.gov

To subscribe email:

listmanager@info-server.lanl.gov

In the message body put:

subscribe omnis 

[ your e-mail address ]

New Sites:
The Client/ Server FAQ

http://www.cis.ohio-

state.edu/hypertext/faq/isenet/client-serv-

er-faq/faq.html

Sybase

http://www.sybase.com

Informix:

http://www.garpc.com/informix.html

ftp://mathcs.emory.edu/pub/informix/faq

Oracle:

http://www.oracle.com

Ingres:

http://www.adc.com/ingres/ing-top.html

DB2:

http://software,watson.ibm.com

Butler SQL and Tango

http://www.everyware.com

Newsgroups:
comp.client-server

comp.databases.sybase

comp.databases.oracle

comp.databases.ingres
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Searching the List
Server
The searchable index to the list servers
records is up and running again. 

The URL is: http://est-4d.lanl.gov/

Mac Clones
Reports are arriving about the Radius
Power Mac Clones will not run the Mac
68k version of the Omnis 7.3.2 product.
They will however run the PowerMac
version. The same situation will probably
exist with all the clone machines as there
is little value in their engineers providing
backward operating system compatibility
in these specialized ‘trade’ machines.

Timely business
and marketing
information for
Apple developers
The Apple Directions Express listserver
provides a regular digest of up-to-the-
minute news and information from Apple,
in the most timely fashion possible.
Delivered electronically via the Internet
right to your desktop, Apple Directions
Express is your glimpse inside Apple, to
help you keep up with what Apple is
doing so you can plot your next business 

You can subscribe by sending e-mail to
adirections@thing1.info.apple.com

In the body of your message, type the
string

subscribe <your real name>

excerpt from forwarded message.
Peter Marks
Developer Support Manager
Apple Computer Australia

PRINTING
Printing Mac Environment
Problem: A Large report prints only the
first one or two pages

In the Laserwriter dialog (not the Page
Setup dialog) there is an option to print
COLOUR/GREYSCALE of BLACK &
WHITE.  You must select Black & White
in order to get all pages to print correctly.

Depending on the printer driver you are
using you may have to go to the

OPTIONS window to get access to this.
This is true in Laserwriter 8.2 and 8.3.
Previous versions it showed on the main
window.

This does not fix the problem with a
Personal Laserwriter - at least not the lat-
est models. 

Printing QuickDraw GX
There appear to be ongoing problems
with QuickDraw GX that can cause mis-
cellaneous general printing problems and
out of memory errors. If you have these
types of problems in Omnis and also in
other programs QuickDraw GX may well
be the culprit.

Printing Windows Environment
GDI Printers:  Blyth, along with numer-
ous other software companies, do not
make any warranty whatsoever in relation
to GDI Printers. This technology  needs
time to mature.  We have received the
same advice from networking and general
computer newsletters as well as from
Blyth.

Emulate Copland
Interface Now!
Aaron is a small extension that transforms
your current MacOS interface, so it close-
ly resembles the Copland Interface.
Features added include:

• Substitution of the old Chicago 12 sys-
tem font with the vastly more legible
Espi Sans Bold 10.

• Push Buttons, Radio Buttons and
Checkboxes are shaded 3D.

• The Menu bar and menus are a pale grey
colour, with the menu bar taking on a
subtle 3D effect.

• Menu Highlight colour is now blue.
• Vastly improved Copland Style folder

Icons.
• Progress bars in the Finder and some

applications take on a futuristic feel.
• If you have a PowerMac or a 68040

based Mac, the Windows will open and
close with a spinning zoom effect.

• A Windowshade button has been added
to the title bar, which also takes on a
3D feel. Folder Icons are also displayed
in the title bar.

This user thinks this to be one of the best
system enhancements available, it does
not appear to clash with other system
extensions, adds a fresh new change to
the whole feel of your Macintosh and

only marginally decreases screen redraw
speed. Aaron is “fat binary” giving opti-
mum performance on both 680x0 and
PowerPC based machines. Aaron has a
mere $10 shareware fee and can be down-
loaded from any of the Info Mac FTP
mirror sites, in the GUI directory. 

Zip Drives
It is Monday morning, the phone rings
and you are confronted with the terrified
voice of your most valued client...
URGENT ACTION is required to resur-
rect their ailing application datafile. No
problem, the datafile is 15MB and the job
super urgent. Until recently it would be a
matter of picking up the trusty Syquest
Drive, a cartridge and speeding off to the
site. Enter Zip drives; small, virtually
indestructible drives designed for use
with specially designed 25MB or 100MB
disks, barely larger than a floppy disk. A
Zip drive weighs around 450g, connects
to either the SCSI or Parallel port and has
access speeds very close to that of con-
ventional hard disks. For the mere price
of $350 it represents a very cost effective
portable storage solution. (Contact
Polaroid Computing).

UUCP Gateway for
Quickmail 3.5
CE Software’s Quickmail has already
demonstrated itself to be one of the best
solutions to internal communications over
LANs and WANs. Version 3.5 now
comes with an UUCP gateway allowing
ten Quickmail users to access the Internet
from any Quickmail server. The
Quickmail Nameserver Application is
also a new release allowing improved
address book updating over large net-
works running Quickmail systems.

Blyth Software on
the Web
It was a while in the waiting, but as of
(September) Blyth have taken it to the
Web. They have provided a formidable
source of Omnis information, resources
and technical tips together with links to
other hot Omnis Web sites. The interface
is stylish and simple to use with informa-
tion logically arranged.

Two products are available for down load 
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off the Web. There is a limited life version of Omnis for
Workgroups (Mac or Windows) and recently a beta of the
Windows 95 version (although this product is a beta it is not sup-
ported by Blyth Technical Support and is only for prototyping
and demonstration purposes).

If you haven’t already done so, point your Web Browser to
http://www.blyth.com

Storing User Preferences In
An Omnis Application
People work with software applications in different ways.  As
developers we can’t always anticipate how our users will want to
use a given application.  It’s often the case that our users will
attempt to do things to our applications that we would never
have dreamed of!  

Whenever possible, users should be given the ability to set up
their work environment as they wish.  Allowing them to set up
preferences is an easy way to let users have some control over
their environment.

In the past, when I wanted to create preferences for my users I
had to create a preferences file to store and retrieve this informa-
tion.  This is not always the most efficient way to do this.

However, using notation in Omnis 7^3 it’s no longer necessary
to create a file to store this information.  We can now create and
store preference information in the application itself.

I created the following preference window for an application I
was working on for a Fortune 100 company.  Despite being very
simple, the users really liked the ability to set the opening win-
dow and whether the “Help” bar comes on or not.  (I usually turn
the Help bar off because I find the constant flashing of the mes-
sage at the periphery of my vision very annoying.)

My simple preferences window looks like this:

As you can see, this window allows the users to set an opening
window and to default the help bar on or off.  I’ve always found
it annoying when I launch an application and after it loads I just
have a menu bar staring at me.  Typically I’m going to access
something and I usually have the same starting point each time.
Opening a default window does two things for me, it tells me the
program is finished loading and I can get to work, and it saves
me a step and I can get going a bit quicker.

The code to manage this is very simple.  The first step is to get
the existing preferences from the application library procedure.  I
used STARTUP 485 and 486 for this purpose.  You could also
put all the preference codes into the same procedure and parse it
out but I think this is more readable.

STARTUP
———-

485  Help Bar Prefs
—————————-
;  1 ;; This is used in the preference window radio button

486  Opening Window Prefs
————————————-
;  2

The STARTUP procedures simply store the preference options.
In this case all I need is an integer to indicate the different
options.  You can store anything you may need or want here.
Note that the data is stored as a comment.
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0  Init
———-
Calculate fv_HelpBarText as mid($clib.$formats.START-
UP.$procs.485.$proctext,4,1)    
;; Get the data from the proc
Calculate fv_HelpBarNum as fv_HelpBarText
Calculate fv_WindowText as mid($clib.$formats.START-
UP.$procs.486.$proctext,4,1)     
Calculate fv_WindowNum as fv_WindowText
Redraw windows
Enter data
If flag true

Calculate $clib.$formats.STARTUP.$procs.485.$proc-
text as con(‘;  ‘,fv_HelpBarText)

Calculate $clib.$formats.STARTUP.$procs.486.$proc-
text as con(‘;  ‘,fv_WindowText)
End If
Close window W_Prefs

There are two things to keep in mind about the notation calcula-
tion to retrieve and store the information from the STARTUP
procedure.  You must begin reading your data string from posi-
tion “4” in the procedure not position “1”. When writing the data
back to the procedure line be sure you have a space between the
“;” and the beginning of the data.

It’s an easy feature to implement and it gives the user a bit of
control over their work environment.  Who doesn’t want a little
more control over their environment?

By Steve Larbig
Araxes Software/ DLA Technology
Steve_Larbig@aapda.com.au
larbig@acm.org  
CompuServe: 76137,501

ODBC Driver/Manager for
Omnis
ODBC is a Microsoft Standard for Database connectivity and
requires three components to work; A Driver Manager such as
O7ODBC.DLL (or a Driver Manager provided by a third party),
a database specific driver such as for Excel, Access, Paradox or
a text file and a database in its original format that the driver can
read such as a dBase4 file. A different driver is typically
required for each backend so if your Omnis application was to
access an Excel spreadsheet, a dBase file and a Paradox file then
you would need a driver manager and three drivers, one for
Excel, one for dBase4 and one for Paradox. ODBC drivers are
accessed using SQL syntax and can be treated like any SQL
compliant DAM that comes with Omnis. ODBC drivers can also
be considered to be an alternative to the so-called ‘Native’
DAMS provided by Blyth. Accordingly, with the correct driver
you could access an Oracle DBMS with either the Oracle Blyth
authored DAM or an Oracle (or third party authored) ODBC dri-
ver. ODBC drivers from the database proprietor are typically
Copyright protected freeware whilst a significant portion of the
market is held by ODBC vendors such as Q&E. 

Blyth have no intention at this time to write an ODBC Driver for
foreign software to access the Omnis native data file.

The ODBC standard has been accepted by Apple and the SDK
for Apple ODBC drivers and is in final beta release.
Accordingly, ODBC is a standard that everyone needs to know
something about.

ODBC is a Microsoft defined databased API based upon the
ANSI SQL 1992 specifications. These specifications are essen-
tially the common set of SQL calls. An ODBC driver for dBase
is no different from a printer driver. The driver has to be at a
known location and loaded at the appropriate time and be itself
pointed at the correct objects. In the case of a dBase ODBC dri-
ver, these objects will be the ODBC Driver Manager and the
database. When you make a SQL SELECT call, the call is
directed towards the Driver Manager which then sends it to the
correct driver which then interprets it so that the DBMS can
understand it. If the DBMS is an application DBMS like Oracle
or Sybase, or performs the instruction itself if accessing a static
file such as an Excel spreadsheet. Drivers that both interpret the
SQL instruction and perform it are known Single tier drivers and
those that simply interpret the instruction and pass it to an ‘intel-
ligent’ backend are known as Multiple tier drivers. Multiple tier
drivers typically act on a DBMS specific client which in turns
communicates with a DBMS specific server file which then
communicates with the DBMS.

An extension of the two tier driver above is the replacement of
the DBMS with a Gateway server, typically a functionality pro-
vided by a DBMS provider such as Oracle or Sybase, which in
turn communicates with a Legacy (old) or mainframe data
source.

In summary, the ODBC standard allows a program to execute
SQL calls to a DBMS not supported by a distinct DAM and to
execute SQL calls against any non-SQL but supported file such
as Excel, ASCII files etc.

Although ODBC is very powerful it has its critics. The main
areas of criticism relate to speed, configuration and maintenance.

ODBC is much maligned in the performance area. Essentially,
all other things being equal, an ODBC 2.0 compliant driver will
be no less than 5% slower than direct API access. With ODBC
1.0 compliant drivers the initial access may only be marginally
slower, but multiple accesses (as there is no bind variable
support) will be significantly slower. 

Essentially personal database products follow the ISAM stan-
dard and DBMS based systems are applications. The DBMS
processes requests on the datafile itself whilst ISAM mode
access relies on the client application to do all the work. As
ODBC supports Stored Procedures, that is, the passing of an
instruction to the DBMS to do some work on the datafile, ODBC
drivers should be compared with Special purpose DAMS not
with Omnis native datafile commands. In the same manner that a
Find First exact match on an indexed field will be much faster in
the DML than by using ODBC, a stored procedure to find
records from a series of files or tables in a DBMS and calculate a
column total will be much faster in a stored procedure than any-
thing a DML based structure will produce.

ODBC Drivers ship with many applications and therefore care-
ful planning is required to overcome a build up in many versions
of the same DLL appearing in the Driver Manager window (See
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Control Panel). All drivers are stored in
the Windows/System pathway. A multi-
tude of similarly named drivers can be a
headache for users and system adminis-
trators alike.

By Stephen Miller
The DLA Group
Stephen_Miller@aapda.com.au

Omnis 7.3.2
The Bug List!
After analysing the complete bug list  the
following bugs in 7.3.2 seem to have pri-
ority for the average developer. Most
bugs recorded are so spurious it is hard to
imagine how they were discovered in the
first place!

The bugs in no particular order are:

• Adding an index to a field using nota-
tion doesn’t work.

• Calling a datafile MY_Data.DF2 when
the datafile is not the second segment of
MY_Data.Df1 is a no no. Omnis
assumes that .DF2 is the second seg-
ment.

• Using Totc(#L1,#L*(COL_1=’value’))
as a search method no longer works.

• The external function call ‘Test for file
exists’ seems to fail after 6-8 calls.

• The calculate command  “Calculate
[Fieldname1] as [Fieldname2]”, that is,
where square bracket notation is used
on both sides of a calculation may be
unreliable.

• A single file find (where no main file
has been set at all, that is the sys() main
file value is empty) may fail.

• If a define list is not the last command
in a reversible block it will not reverse
properly.

• If before a reversible block there is no
main file, a setting of the main file in a
reversible block will not be reversed
out.

• Reversible blocks and finds should be
examined for correct reversals, if you
are calculating the value of the field to
be found then this code should be in the
reversible block. Otherwise the original
value may not be re-read into the CRB.

• Window Control Procedures are not run
when the window first opens.

• Fld() and jst() functions have a limit of
100 parameters each.

• SNA perform a tab may have
problems in your app..if so use
Queue a tab.

• Special characters in library
names may cause errors on open-
ing.

• Watch out for type mis-matches in
date searches. To be on the safe
side the dat() function should be
used to force a type match.

• The time() function truncates min-
utes  greater than 60, that is,
resets the counter so you may
need the H:M:S formats.

• Len() on a null variable returns 1
instead of 0.

• Rnd() on both sides of a expres-
sion is incorrectly evaluated.

• In certain situations the search list
function may not correctly set the
flag. Please check you app thor-
oughly.

• Problems may occur using the
pck() function in calculated fields
in reports.

• Please don’t overreact to this list.
Omnis 7.3.2 is a very stable prod-
uct!

By Stephen Miller
The DLA Group
Stephen_Miller@aapda.com.au

Codename
Copland
Codenamed Copland, Apple’s first major
rewrite to the MacOS is due for release in
the coming year. Included will be
improved networking via “Open
Transport” and Apple’s Component soft-
ware system “OpenDoc”.  

Networking
The Open Transport networking architec-
ture is the key to Copland’s improvement
of network setup, use and administration.
Open transport shields applications from
network protocols and integrates LAN,
WAN, modem, and remote dialup net-
working. Along with the support for
Appletalk, Copland now introduces built
in support for TCP/IP and IPX/SPX net-
works. Users also have an open mecha-
nism for the addition of other protocols. 

Open Transport brings vastly improved
access for Mac users to different networks
as well as change between networks on
the fly. Open transport can utilise the pre-
emptive multitasking and memory protec-
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tion features of Copland which will in
turn optimise network performance and
stability. Copland also provides improved
network browsing tools for improved
access to all shared network resources.

OpenDoc
OpenDoc based software provides the
user with a document based work system
rather than the conventional application
based work system. In this way during
document creation the user need only load
the tool sets required for the task at hand.
Tool sets are provided by OpenDoc com-
ponent applications, which can be mixed
and matched according to the document
requirements. For example within a single
document, users can edit text, manipulate
graphics, perform spreadsheet functions
etc without the hassle of managing sever-
al applications.

OpenDoc is a multiplatform, open stan-
dard in the making for MacOS, Windows,
OS/2 and UNIX operating systems.
OpenDoc will also provide full interoper-
ability  with Microsoft’s OLE 2.0 and
other component software architectures.

The OpenDoc 1.0 Internet Distribution
Center has everything you need to begin
creating OpenDoc components, contain-
ers and extensions!

OpenDoc 1.0 has gone final and is avail-
able for ftp from the following site:
http://www.opendoc.apple.com/

By Stuart Anderson
The DLA Group
Stuart_Anderson@aapda.com.au

Shell lbr
Many developers, including the writer,
intially regard the Omnis shell.lbr as
being more of a nuisance than anything
else. To disable the shell.lbr, to remove
the request message on opening Omnis,
simply remove the shell.lbr library from
the externals folder. Be careful where you
copy it to though as there is another copy
of the shell.lbr in the tools folder or direc-
tory. The shell.lbr in the externals folder
is locked. The copy in the tools directory
is unlocked and is provided for you to
study and enhance. Any Omnis library
placed in the externals folder will execute
immediately on starting Omnis as the

Omnis executable looks to this folder for
libraries to open in the background. (This
is a feature that you can utilise in your
single or multiple library applications).
The shell.lbr has some excellent features
such as the Form Builder and SQL tools
that will help the developer new to SQL.
We suggest that you use the shell to log-
on to a Omnis SQL session and access an
existing Omnis datafile. The Prototype
sub-menu then gives you access to the
SQL Form Builder that will build com-
plete SQL coded windows of several
types. You can store these automatically
generated windows in a new or existing
library and then access them again but
remember to logon to the Omnis SQL
session first or you will get nothing but
errors. 

The Tools menu of the shell provides an
excellent introduction to SQL and should
be studied to clarify the shortcomings of
the written explanations. Note that Omnis
SQL does not support multiple outer joins
and it is unlikely that this situation will
change. Oracle, Sybase and Microsoft
SQLServer do support multiple outer
joins and are better choices than Omnis
SQL as a proto-typing environment.

By Stephen Miller
The DLA Group
Stephen_Miller@aapda.com.au

Controlling the
User
Controlling users ability to modify their
work environments can be critical in
multi-user sites.  Modifying the default
settings can be relatively easy in the
Microsoft world but requires third party
software for the Mac.

PROGMAN.INI: Program Manager
Initialisation File
The Program Manager initialisation file,
PROGMAN.INI, usually has two block
entries for [settings] and [groups] sec-
tions, which control the appearance of the
Program Manager Window. 

A systems administrator might also
choose to add a third section, [restric-
tions], for custom installations.This fea-
ture is particularly useful for large net-
work sites, where admistration costs are
an issue, or, for sites where users inexpe-
rience and centralised control are issues.

[restrictions]
A [restrictions] section can have the fol-
lowing entries:

[restrictions]
NoRun=
NoClose=
NoSaveSettings=
NoFileMenu=
EditLevel=

Entry Definition:
NoRun=1
Disables the Run command on the File
menu.  The Run command appears
dimmed on the File menu and the user
cannot run applications from Program
Manager unless the applications are set up
as icons in a group.

NoClose=1
Disables the Exit Windows command on
the File menu . Users cannot quit Program
Manager through the File Menu or the
Control menu (the Exit Windows and
Close commands are dimmed), or by
using ALT+F4.

NoSaveSettings=1
Disables the Save Settings on Exit com-
mand on the Options menu.  The Save
Settings command appears dimmed on
the Options menu and any changes that
the user makes to the arrangement of win-
dows and icons are not saved when
Windows is restarted.  This setting over-
rides the SaveSettings= entry in the [set-
tings] section of the PROGMAN.INI file.

NoFileMenu=1
Removes the File menu from Program
Manager.  All of the commands on that
menu are unavailable.  Users can start the
applications in groups by selecting them
and pressing ENTER, or by double-click-
ing the icon.  Unless you have also dis-
abled the Exit Windows command, users
can still quit Windows for Workgroups by
using the Control menu or ALT F4.

EditLevel=n
Sets restrictions for what users can modi-
fy in Program Manager. You can specify
one of the following values for n:

n=0 allows the users to make any change.
(This is the default)

n=1 prevents the user from creating,
deleting, or renaming groups.  If you
specify this value, the New, Move, Copy,
and Delete commands on the File menu
are not available when a group is selected.
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n=2 sets all restrictions EditLevel=1, plus
prevents the user from creating or delet-
ing program items.  If you specify this
value, the New, Move, Copy, and Delete
commands on   the File  menu   are not
available.

n=3 sets all restrictions in EditLevel=2,
plus prevents the user from changing
command lines for program items. If you
specify this value, the text in the
Command line box in the Properties dia-
logue box cannot be changed.

n=4 sets all restrictions in EditLevel=3,
plus prevents the user from changing any
program item information.  If you specify
this value, none of the areas in the
Properties dialogue box can be modified.
The user can view the dialogue box, but
all of the areas are dimmed.

To enable any of the commands or
remove any of the EditLevel= restric-
tions, either remove the entry from the
PROGMAN. INI file, or set the value to
0.

These features are very powerful and rel-
atively unknown. They certainly restrict a
users freedom but can significantly sim-
plify maintenance. More information can
be obtained by reading the relavent sec-
tions of Microsoft Resource Kit.

In the Mac world, various third party
software pieces are required to achieve
the same control. One product, recently
displayed at MacWorld in Sydney,
Australia is a suite of software distributed
by Checkmark Technologies of Neutral
Bay (+612 957 6970). MacPrefect,
MacAdministrator and DiskPrefect are a
suite of programs which allow a network
adminstrator to establish an interface and
control all changes to it. Diskbooting is
prevented by DiskPrefect unless a one
use code  provided by telephone is
entered. MacPrefect is a product with an
extensive history in the education world.
Control over all setups is allowed as well
as control panel usage, which applica-
tions can be loaded, where documents can
be saved etc. MacAdministrator is a large
site  application which controls logon
capacity and time controlled access, stor-
age of  work enviroments by user or
group, a server based documents folder
for each user, print usage monitoring,
hardware and software audits and auto-
matic client software upgrades.

No warranty is made in relation to the

above software and the information is
provided for the information of readers
only. Other products with similar charac-
teristics may exist.

By Stephen Miller
The DLA Group
Stephen_Miller@aapda.com.au

AAPDA MCS 
Now Available On
Internet
The MCS, AAPDA's FirstClass server,
may now be accessed over the Internet by
members who use the FirstClass client
software and have a connection to the
Internet.

The MCS's Internet IP address is
203.14.177.200.  Connections are accept-
ed at port 3004, avoiding long distance
telephone charges. To access the MCS
over the Internet, follow these steps:

1) Ensure you are using FirstClass Client
2.6 or later for Macintosh and version
3.0 for Windows.  Only these versions
support  IP connections using the fol-
lowing method.

2) Ensure your connection to the Internet
is a PPP, SLIP or better connection
from a service provider, university or
other organization with full-time
Internet access.  If you do not under-
stand terms such as PPP or SLIP, con-
tact an organization whose business is
to offer Internet access.

3) Edit a copy of your FirstClass settings
file for the MCS, substituting the above
IP address in the Server field of the
connection setup window.  Choose
TCP-IP.FCP as your connection
method.

4) With the connection setup window still
open, verify that the port you are about
to try contacting is port 3004.  Press the
Setup button beside the Connect via
popup, and check the "advanced set-
tings" of your TCP connection for the
port number.  Change it to 3004 if nec-
essary.

5) Initiate your Internet connection and
press the FirstClass Login button.  You
will be connected to AAPDA's MCS.
The performance you experience will
depend on the bandwidth of your
Internet connection and network traffic
conditions.

If you connect to multiple servers at dif-
ferent port numbers, consider duplicating

your TCP-IP.FCP file, renaming it
TCP3004.FCP and preconfiguring it for
port 3004 connections.  Select it as your
connection method in your MCS settings
file.  This will save you having to recon-
figure your default port if you connect to
other systems at other port numbers.

Limits & Performance
The speed of your connection to
AAPDA's MCS will vary depending on
Internet traffic and the speed of the final
connection to your machine. This is a
function of the Internet, and not of
FirstClass.

OMNIS 7.3.5
Omnis 7.3.5  is scheduled for release in
February, 1996.

Proposed Feature Enhancements for
all platforms:

• Window objects: you can place tool
bars, menu bars, and status bars inside
window frames making your windows
self-contained. 
• SQL Data Transfer: lets you copy SQL
data and table structures between sessions
using drag and drop. 
• Notation Helper: a new tool that helps
you write valid notation; it can test nota-
tion as you type. 
• Library Differences: a new library utili-
ty that lets you compare two different
versions of the same library. 
• Procedure Checker: a new tool that lets
you scan your procedures for errors and
potential problems; you can check proce-
dures in individual formats or entire
libraries. 
• Application Builder: a new tool that lets
you define application rules that govern
the behavior of forms in your library. 
• Report Interleaving: combines one or
more Omnis reports and sends them to
the printer as a single document. 
•DAMs: the ODBC DAM is now avail-
able on the Macintosh and PowerMac.
There are other important changes for the
Omnis DAMs; see the Update manual for
details. 
• Graphs documentation: there is a com-
pletely new Graphs manual (printed copy
and Acrobat PDF file) containing a
Developer’s and Reference section, and
the new Tutorial manual contains a chap-
ter about Omnis Graphs. 
• Attribute Inspector: lets you sort attrib-
utes by name or number, and filter out the
standard attributes for ease of use. 
• Field names window: constants and
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functions are now arranged in groups
for ease of access. 
•Numeric Input Masks: place holders
for numeric fields have been added. 
• SQL Server DAM: support for
System 10 data types and cursors. 
• Oracle DAM: support for Oracle
SQL*Net 2.1.

Windows Only Enhancements:
• WinRunner: gives you support for
Mercury Interactive’s automated soft-
ware testing tools. 
• OLE2: gives you OLE2 support
under Windows. 
• Lotus Notes: support for Lotus
Notes version 3.2 under Windows. 

Windows 95 only:
This version gives full support for
Microsoft’s new OS. 

Other features the writer has noticed
is that the development environment
appears to be quicker, many of the
design windows have been mod-
ernised with 3D features, the F9 field
names window has been considerably
improved and the annoying “Snap-
back” list redraw bug has been fixed.

Problems with
Saving Formats
From an OMNIS 7.3.2 perspective,
the safest way to ensure that your for-
mat changes are saved is to execute
the “Save Library” command fre-
quently.  OMNIS will do all that it
can to force a disc write when it exe-
cutes this command.  Blyth plans to
return the “Auto Save” functionality
to OMNIS in the next release of
OMNIS following OMNIS 7.3.2. 

You might also consider turning off
the “Write Behind Cache” option in
DOS to reduce your exposure to
operating system caching in the event
of a crash, or take other steps to
reduce the risk of problems related to
caching, depending on your platform
or hardware configuration.  You may
view the parameters for this option by
typing “smartdrv /?” at your DOS
prompt, and current settings via the
“smartdrv /v” command.  Executing
the command “smartdrv C” will turn
off “Write Behind Cache” for the C
drive, and “smartdrv /x” command
will turn it off for all drives.
Windows should not be running

when these DOS commands are exe-
cuted.  We cannot predict what other
effects this might have on your oper-
ating system environment, but
believe that this will provide the
greatest possible chance of prevent-
ing the loss of work during unexpect-
ed application or system events.

Blyth Technical Support

Appleshare 4.1
Read-Ahead
Buffer
This means a large cache is good if
you want to read large contiguous
files.This means a large cache is
VERY VERY bad if you want to use
Omnis. Therefore, to optimize perfor-
mance of Omnis file-sharing databas-
es where the datafile is stored on an
Appleshare volume, be sure to set the
File Server cache prefs as small as
possible.

General
Protection
Faults
If you are having trouble with GPF's
then the first thing to do is to restart
Windows and try again!  Run the
debugger through your code and if
the GPF occurs when a DLL is load-
ing or running, then the culprit may
be that the wrong version of the DLL
is being loaded. Windows looks for
DLL's in the following order:

• in memory
• the WINDOWS directory
• the WINDOWS\SYSTEM directory
• the DOS path
• the directory in which the applica-
tion resides

Dr Watson and Winspector are two
applications that monitor system calls
and write the calls to a text file before
performing them. The beauty of these
applications is that they identify
exactly what has called the GPF and
can save you many hours of work.
Winspector appears to be shareware
as no copyright is claimed. Dr
Watson appears to have been
licenced by Microsoft at one stage, (v
0.8), and may be in your WIN-
DOWS\SYSTEM folder. 

SAVING RAM
The basic techniques for minimising
RAM requirements are to use
Optimize Procedure, clear lists when
finished with them, use the Clear
Format Variables when Closed
option and to use the Revert Format
command to clear unneeded formats.
RAM resident formats can be estab-
lished by building a current windows
list using notation. The Revert
Format command is poorly docu-
mented and it is suggested in the
manual that this command reloads the
stored version of the format into
RAM. It doesn’t, its action is simply
to clear the selected format from
RAM.

Much much more on RAM use in the
next issue of OmniDirecional.
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Grandfathering Omnis 7.3.x Enterprise Kit
Owners
Owners of the Enterprise Kit prior to the release of the Omnis Workgroup product are enti-

tled to purchase the PowerMac; and NT Versions at a significant reductions off the previous

pricing. The new pricing is $120 per platform.

DLA Retail Mini-Price LIST
WorkGroup Product (development environment plus 10 user Runtime) $   799

Omnis for Oracle(as per Workgroup plus Oracle DAMS)                               $2,799

Omnis Enterprise Kit(all DBMS DAMS) $5,100

NT, PowerMac Development environments for Enterprise Kit

Owners prior to 1/10/95 $   120

Upgrades

Omnis for Oracle from Workgroup ( Mac OS’s or Windows OS’s each) $2,195

Enterprise Kit from Omnis for Oracle  ( Mac OS’s or Windows OS’s each)     $2,859

Enterprise Kit from Workgroup   ( Mac OS’s or Windows OS’s each)              $4,595

Run-times

Omnis 5 limited number of single user and multi-user available...please call.

7.1.4 or 7.2.2 Single user serial numbers for workstation deployment            $   180

As above for server-deployment (single and multi-user no.s)   $   360

7.3.2  per user                                 $     90

Manuals-  7.3.2 Enterprise Kit $   120


